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Guide to IPC Reform implementation in STN databases

STN provides enhanced 
access to IPC Reform data
On January 1, 2006, the World Intellectual 
Property Organization’s (WIPO) 
International Patent Classification (IPC) 
Reform went into effect for patent-issuing 
authorities using IPC codes or “symbols.”  
IPC Reform codes, commonly referred to 
as IPC 8 codes or post-Reform codes, are 
intended to enhance search and retrieval 
efforts and efficiency through this new 
standard classification index. 

New patent records issued after this date 
are expected to have new IPC codes, 
which will be included in STN patent 
databases.  In tandem with the reform 
efforts, the European Patent Office (EPO) 
has reclassified over 50 million existing 
patents to conform to the IPC Reform. 

Important changes are being implemented 
in the STN product line, including STN 
AnaVist, to accommodate the IPC Reform.  
The changes benefit you by ensuring 
continued access to and enhanced 
searching of IPC data in STN products.

STN enhancements 
accommodate IPC Reform
STN is actively implementing IPC 8 data 
into its patent databases. The STN 
implementation provides access to new 
additional information provided with IPC 
8, enables file crossovers, and provides 
multifile searching capabilities. 

All IPC code-containing patent databases 
on STN and in STN AnaVist are able to 
accommodate patent documents with new 
IPC 8 codes.  Because the use of IPC 8 
codes by patent-issuing organizations 
began during the week of January 1, 2006, 
this information is now available in STN 
databases.  

The table outlines the many STN databases 
that contain IPC 8 data as well as the IPC 
thesaurus.

In addition, the content of the /IPC field has 
been redefined to include all IPC codes.  
/IPC now includes all IPC codes, i.e., initial 
and reclassification codes.  The new IPC 
field should be considered as the Basic 
Index for IPC code information.

  IPC Reform codes, commonly 
referred to as IPC 8 codes      

or post-Reform codes,                
are intended to enhance         

search and retrieval efforts         
and efficiency                       

  through this new standard 
classification index. 

Similar changes are implemented in 
many other STN databases as database 
producers of other IPC code-containing 
patent databases provide post-IPC Reform 
data. 

For database-specific information regarding 
IPC 8 implementation, enter HELP IPC or 
HELP CHANGE at an arrow prompt (=>)
in the database.
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Key benefits 

• IPC code-containing patent databases 
on STN are being enhanced to ensure 
that patents published with IPC 8 
codes are accommodated.

• STN patent databases are able to 
accept IPC codes in either pre- or 
post-Reform format for searching 
(see the IPC Reform and STN checklist). 
There is no need to reformat the IPC 
codes in your strategies.  

• Cross-field searching capabilities 
have been retained. It is possible to 
search a pre-Reform IPC code, without 
reformatting, in the revised /IPC field. 
It is also possible to search an IPC 
7 code in an IPC 8 format, without 
reformatting, in the /ICM field, which 
appears only in pre-Reform records. 

• You can DISPLAY or SELECT pre-
Reform IPC codes in the new IPC 
8 format by using the new SET 
command, SET ICFORMAT ON. 

• A new version of the IPC thesaurus 
is available for use in many IPC 
code-containing databases on 
STN (see the IPC Reform and STN 
checklist), enhancing your searching 
opportunities in these databases.

• Patent family members in the CA/
CAplus family of databases have been 
enhanced with the addition of available 
IPC code information for many 
patent family members, including the 
backfile, providing additional retrieval 
opportunities for patent documents 
included in CA/CAplus.

IPC Reform and STN checklist (as of April 3, 2006)*

   IPC code 
Database 2006 patent data  search format IPC thesaurus

CASM/CAPLUSSM Included IPC 7 or 8 Available

DPCI Included IPC 7 only 

ENCOMPPAT/ENCOMPPAT2 Included** IPC 7 or 8 

EPFULL Included IPC 7 or 8 Available

FRANCEPAT Included IPC 7 or 8 Available

FRFULL  IPC 7 only 

GBFULL  IPC 7 only 

IFIPAT/IFIUDB/IFICDB Included IPC 7 or 8 

INPADOC Included IPC 7 or 8 Available

JAPIO  IPC 7 only 

KOREAPAT  IPC 7 only 

PAPERCHEM2 No longer  IPC 7 or 8 
 adding patents

PATDD  IPC 7 only 

PATDPA Included*** IPC 7 only 

PATDPAFULL Included IPC 7 or 8 Available 

PATDPASPC Included IPC 7 or 8 Available

PCTFULL Included**** IPC 7 only 

RUSSIAPAT Included IPC 7 or 8 Available

TULSA/TULSA2 Included** IPC 7 or 8 

USPATFULL/USPAT2 Included IPC 7 or 8 Available

WPINDEX/WPIDS/WPIX Included IPC 7 only 

WPIFV Included IPC 7 only 

* For the most current information, visit www.cas.org/EO/ipcdbcode.html. 
** 2006 patent records show IPC codes in IPC 7 format. 
*** Loaded IPC 8 data without attributes.
**** Updated without IPC 8 data.
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New SET command

The introduction of a new SET command, 
SET ICFORMAT ON, allows you to SELECT 
and DISPLAY pre-Reform IPC codes in the 
post-Reform IPC format.

Implementation of IPC reclassification 
data 

A number of IPC code-containing patent 
databases on STN are being enhanced 
with updated IPC information in existing 
patent documents based on a major IPC 
reclassification project.  You will find this 
data in the IPC Reclassification (IPCR) field.  
A file with over 50 million reclassifications 
was delivered in late December 2005 and 
is currently being processed to extract 
relevant data for individual STN databases. 
The implementation of reclassification 
data in USPATFULL/USPAT2, INPADOC, 
and RUSSIAPAT on STN is complete.  
Significant progress has been made in the 
implementation of reclassification data into 
CA/CAplus.  See the CAS IPC Reform web 
page for the latest information:
www.cas.org/EO/ipcreform.html

For database-specific information and 
progress status regarding reclassification 
data implementation, enter HELP RECLASS 
at an arrow prompt in each database.

New IPC fields

New search fields have been added to accommodate the IPC Reform.  A description 
follows of the fields implemented for the CA/CAplus family of databases, which serves as 
the model for other databases. 

New search field Code Description

IPC Keywords IPC.KW IPC code metadata “descriptor keywords.”

IPC Action Date IPC.ACD Indicates when the IPC code was applied to  
  the patent or updated.

IPC Version Date IPC.VER Provides a date associated with the last  
  version change to the IPC code in the   
  manual of classification.  The date can be  
  searched in YYYYMM or YYYYMMDD format  
  and displayed in YYYYMM format.

Old IPC codes IPC.OLD The former /IPC super search field has been  
  renamed IPC.OLD and includes the IPC  
  codes indexed in the former /IC, /ICI, and 
   /ICA fields for basic patents only.  This field  
  is valid only in CA, CAplus, USPATFULL,  
  and USPAT2.

Initial IPC codes IPCI IPC codes associated with the patent when  
  it was first published.

Reclassification IPC codes IPCR IPC codes associated with a patent that has  
  been reclassified with IPC 8 codes.

IPC Basic IPC.B IPC codes for the basic patent.  This field is  
  valid only in CA/CAplus.
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IPC 8 thesaurus

A new version of the IPC thesaurus is 
available for use in many IPC code-
containing databases on STN.  It has 
already been implemented in the CA/
CAplus family of databases, EPFULL, 
FRANCEPAT, INPADOC, PATDPASPC, 
RUSSIAPAT, and USPATFULL/USPAT2. 

The implementation of the IPC thesaurus 
in STN databases that did not previously 
contain this information will enhance your 
searching opportunities in these databases.
It is expected that IPC codes will be 
revised more often in the future, and 
reclassifications done more frequently.  
Therefore, you will need to periodically 
check the revised manual of classifications 
offered by WIPO to ensure that the 
IPC codes you are using are still valid.  
Alternatively, you can use the IPC 8 
thesaurus available within STN databases 
to verify code validity.  

The revised manual of classifications, 
which is the source material for the IPC 8 
thesaurus, is available at:
www.wipo.int/classifications/ipc/ipc8/

For information about using the IPC 
thesaurus, enter HELP THES and HELP 

Impacts on searching 
STN databases
Following are items to consider when 
searching IPC data.

Up-posting of IPC 8 codes makes 
truncation unnecessary

Are you using truncation when searching 
IPC 8 codes?  It is really not necessary 
due to up-posted IPC codes.  Search any 
IPC code at the main group level, e.g., S 
A61K0005/IPC, and retrieve records with 
any corresponding subgroup.  Although 
you will get the exact same results by 
searching A61K0005?/IPC, the latter search 
takes longer (with higher connect-hour 
charges), and with certain IPC codes, there 
is the risk of exceeding truncation limits. 

Another reason not to use truncation while 
searching IPC codes is a new system 
feature that allows you to search IPC codes 
in either IPC 7 or 8 formats.  This feature 
interprets codes entered in IPC 7 format 
with truncation as codes already in IPC 8 

format.  If you enter S A61K005?/IPC, the 
system will search IPC codes A61K0051, 
A61K0052, etc., and not A61K0005 and 
its various subgroups.

Saved search strategies and 
current-awareness alerts (SDIs)

If you have included IPC codes in your 
saved search strategies or in current-
awareness alerts in STN databases, you will 
need to review your strategies and make 
edits, as necessary. 

In the post-Reform era, continued use of /
IC, /ICA, /ICI, /ICM, or /ICS restricts retrieval 
to those patent documents published with 
pre-Reform IPC codes.  The use of the /IPC 
search field is recommended instead.

Any IPC codes included in your search 
strategies should be verified against the 
revised manual of classifications available 
from WIPO or in the online thesaurus to 
ensure their continued validity. 

Additional resources
Reference the Patent Interchange article, Searching and displaying IPC Reform data, in 
this issue of STNews. 

In addition, see the Patent Interchange article, Verifying IPC codes with the IPC 
thesaurus in CA/CAplus and USPATFULL/USPAT2, in the January/February 2006 
issue of STNews.

More information on the IPC Reform is available at: 
www.cas.org/EO/ipcreform.html 

www.stn-international.de/stndatabases/details/ipc_reform.html 

STN Database Summary Sheets are available at: 
www.cas.org/ONLINE/DBSS/dbsslist.html 
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CA/CAplus
–IPC range searching now more flexible

IPC code range searching is now more flexible in the CA/CAplus 
family of databases.  You can use a hyphen with spaces as a 
separator in IPC range searching.  You can now also use a colon 
between the codes in your search; the presence or absence of 
spaces is accommodated.  

The following searches retrieve the same number of results:

=> S C08G0018-00-C08G0018-38/IPC

=> S C08G0018-00 - C08G0018-38/IPC

=> S C08G0018-00-  C08G0018-38/IPC

=> S C08G0018-00  -C08G0018-38/IPC

=> S C08G0018-00:C08G0018-38/IPC           

=> S C08G0018-00 : C08G0018-38/IPC

=> S C08G0018-00:  C08G0018-38/IPC

=> S C08G0018-00  :C08G0018-38/IPC

This flexibility is intended for implementation in STN patent 
databases already containing the IPC thesaurus.  It will be 
implemented in other databases newly enhanced with IPC 8 
data at the time the IPC thesaurus is installed.

The CA/CAplus Database Summary Sheets are available at:
www.cas.org/ONLINE/DBSS/cass.html
www.cas.org/ONLINE/DBSS/caplusss.html

EMBASE
The Excerpta Medica database
–database now updated daily

EMBASE is now updated on a daily, rather than a weekly, basis.  
Current-awareness alert (SDI) frequencies in EMBASE remain the 
same—weekly (default) and biweekly.

The revised EMBASE Database Summary Sheet is available at:
www.cas.org/ONLINE/DBSS/embasess.html

EPFULL
European Patent Fulltext
–database updated; IPC 8 enhancements added

Updates for EPFULL have resumed and are now being 
implemented on a weekly basis.  

EPFULL now contains IPC 8 codes, used according to the rules of 
the IPC Reform (IPC 8), for 2006 EPO publications.  

The IPC thesaurus also has been implemented for the first time in 
EPFULL.  The thesaurus is available in the /IPC search and expand 
field, allowing you to view the definitions of IPC codes in their 
respective hierarchies.  It also enables searching across a range of 
IPC codes.

A concise description of the functionality is provided when you 
enter HELP THES at an arrow prompt (=>) in one of the databases 
containing the IPC 1-8 thesaurus.  The hierarchy or relationship 
codes are available with HELP RCO.

For details of the IPC-related enhancements, including the addition 
of the IPC thesaurus, see HELP CHANGE in EPFULL.

Search tips for using the IPC thesaurus can be found starting on 
page 48 at:  
www.stn-international.de/ipcreform_stn.html

For more information on the IPC Reform, visit:
www.cas.org/EO/ipcreform.html 
www.stn-international.de/stndatabases/details/ipc_reform.html

The EPFULL Database Summary Sheet is available at:
www.cas.org/ONLINE/DBSS/epfullss.html  

FRANCEPAT
–database updated; IPC thesaurus added 

Updates for FRANCEPAT have resumed and are now being 
implemented on a weekly basis.  

FRANCEPAT now contains IPC 8 codes, used according to the 
rules of the IPC Reform (IPC 8), for 2006 EPO publications.  

The IPC thesaurus covering IPC 1-8 is now available in 
FRANCEPAT.  The thesaurus is available in the /IPC search and 
expand field, allowing you to view the definitions of IPC codes in 
their respective hierarchies.  It also enables searching across a 
range of IPC codes.
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A concise description of the functionality is provided when you 
enter HELP THES at an arrow prompt (=>) in one of the databases 
containing the IPC 1-8 thesaurus.  The hierarchy or relationship 
codes are provided in HELP RCO.

Search tips for using the IPC thesaurus can be found starting on 
page 48 at:  
www.stn-international.de/ipcreform_stn.html

For more information on the IPC Reform, visit:
www.cas.org/EO/ipcreform.html 
www.stn-international.de/stndatabases/details/ipc_reform.html

The FRANCEPAT Database Summary Sheet is available at:
www.cas.org/ONLINE/DBSS/francepatss.html

INPADOC 
INternational PAtent DOcument Center
–IPC thesaurus added; status of current WO information

The IPC thesaurus covering IPC 1-8 is now available in INPADOC.  
The thesaurus is available in the /IPC search and expand field, 
allowing you to view the definitions of IPC codes in their respective 
hierarchy.  It also enables searching across a range of IPC codes.

A concise description of the functionality is provided when you 
enter HELP THES at an arrow prompt (=>) in one of the databases 
containing the IPC 1-8 thesaurus.  The hierarchy or relationship 
codes are provided in HELP RCO.

Search tips for using the IPC thesaurus can be found starting on 
page 48 at:  
www.stn-international.de/ipcreform_stn.html

For more information on the IPC Reform, visit:
www.cas.org/EO/ipcreform.html 
www.stn-international.de/stndatabases/details/ipc_reform.html

Beginning in January 2006, the World Intellectual Property 
Organization (WIPO) started to deliver its data in a new format.

Because of difficulties with the new format delivery, WO 
bibliographic data published in 2006 are not yet covered in 
INPADOC; they are expected to become available soon.

The revised INPADOC Database Summary Sheet is available at: 
www.cas.org/ONLINE/DBSS/inpadocss.html 

INSPEC® 
Information Service for Physics, Electronics, and 
Computing
–reloaded and enhanced

INSPEC, produced by the Institution of Engineering and 
Technology (IET), has been reloaded and enhanced with more 
granular search fields for the abstract and controlled terms.

The enhancements include:

• Stop words are no longer used.

• New search and display fields:

- Abstract (/AB) – now separately searchable and displayable

- Availability (/AV) – original documents, mainly for reports, 
dissertations, and conference proceedings

- Controlled Word (/CW) – additional to the bound phrase index 
Controlled Term (/CT)

- Specific source information search fields were added to the 
Source (/SO) field:

 International Standard (Document) Number          (/ISN)

 Meeting Date          (/MD)

 Meeting Location          (/ML)

 Meeting Title         (/MT)

 Publisher          (/PB)

 Uniform Resource Locator          (/URL)

- Reference Count (/REC)

- Word Count, Title (/WC.T)

• Patent and priority numbers are now searchable in the /PNO and  
/PRNO fields, but in the original format only.  In addition, Patent 
Assignee (/PA), Application Year (/AY), Application Date (/AD), 
Priority Year (/PRY), and Priority Date (/PRD) search fields have 
been added.  Note that INSPEC’s patent coverage is limited to 
U.K. (GB) and U.S. publications from 1968-1976.

• Simultaneous left and right truncation (SLART) is now available  
in the abstract (/AB) and title (/TI) fields, in addition to the Basic 
Index (/BI).

Current-awareness alerts (SDIs) and saved answer sets are not 
affected by these enhancements.

The revised INSPEC Database Summary Sheet is available at:
www.cas.org/ONLINE/DBSS/inspecss.html 
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MARPAT®

–improved structure highlighting in FQHIT and QHIT display 
formats

Structure highlighting in the FQHIT and QHIT display formats in 
MARPAT has been improved.  The FQHIT display format shows 
the first query-focused Markush structure containing the query 
structure and the fields containing hit text terms in the record.  
The QHIT display format provides fields containing hit text terms 
and the query-focused Markush structures containing the query 
structure. 

Displays have been algorithmically enhanced to provide accurate 
highlighting and offer a review of results more quickly and 
effortlessly.  

In the following example from a current display of CA 127:55912, 
the QHIT format does not show where G6 fits in the structure:

L3 ANSWER 1 OF 1 MARPAT COPYRIGHT 2005 ACS on STN
MSTR 1

G1     = OH
G6     = Cb<EC (6-7) C, AN (1) C, AR (0), BD (ALL) SE, 
       RC (1), RS (1) M6 (1) X7>

The highlighting improvements clarify the display by adding more 
detail with G2:

MSTR 1

G1     = OH
G2     = 10

G6     = Cb<EC (6-7) C, AN (1) C, AR (0), BD (ALL) SE, 
       RC (1), RS (1) M6 (1) X7>

The MARPAT Database Summary Sheet is available at:
www.cas.org/ONLINE/DBSS/marpatss.html

MEDLINE®/LMEDLINE 
–reload improves functionality

MEDLINE/LMEDLINE on STN have been reloaded (February 26, 
2006).  The reload included several enhancements:

• The Source (/SO) field now contains the International Standard 
Serial Number (ISSN) for print and the Electronic ISSN (E-ISSN) 
for electronic journals when available.  Both print and electronic 
ISSNs are searchable and displayable in MEDLINE.

• Stop words are now indexed, so your search may now include 
the following words:  AN, AND, AS, AT, BY, FOR, FROM, IN, NOT, 
OF, ON, OR, THE, TO, and WITH.  

• A new search and display field, COMMENT (/CM), is now 
available and displays after the SO field in the ALL format.  The 
CM field does not display in the BIB format.  The terms from SEL 
CM with Document Number (/DN) appended allow you to find 
referenced PubMed IDs in MEDLINE.

• OLDMEDLINE records now include at least one MeSH heading 
in the Controlled Term (/CT) field.

• Simultaneous left and right truncation (SLART) is now available 
in the Title (/TI) field, the same as in the Abstract (/AB) and Basic 
Index (/BI) fields.

• Publication Date (/PD) is a new numeric field in the YYYYMMDD 
format that is searchable and selectable.

• Publication dates are searchable in the /SO field, but not in the 
numeric YYYYMMDD format.  

The annual update on December 11, 2005, to Medical Subject 
Headings (MeSH), the National Library of Medicine’s (NLM) 
controlled vocabulary used for subject indexing and retrieval, 
included:

• Over 990 new MeSH Headings 

• More than 185 updated MeSH Headings to reflect more current 
terminology  

For example, Fetal Anoxia is now indexed under Fetal Hypoxia.

=> S FETAL HYPOXIA/CT

L1        2192 FETAL HYPOXIA/CT  (4 TERMS)
                 (‘FETAL HYPOXIA’+XUSE/CT)

=> S FETAL ANOXIA/CT

L2        2192 FETAL ANOXIA/CT  (4 TERMS)
                 (‘FETAL HYPOXIA’+XUSE/CT)

You may want to update your current-awareness alerts (SDIs) and 
saved queries to reflect the MeSH terminology changes.  However, 
regardless of the term you enter, STN recognizes the relationship 
between the old vocabulary and the new terms and will link them 
automatically.

For more information about changes in the 2006 MeSH, visit:
www.nlm.nih.gov/pubs/techbull/nd05/nd05_med_data_changes.
html

The revised MEDLINE/LMEDLINE Database Summary Sheets are 
available at:
www.cas.org/ONLINE/DBSS/medliness.html 
www.cas.org/ONLINE/DBSS/lmedliness.html 
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PATDPASPC
German Supplementary Protection Certificates for 
Drugs and Protecting Agents
–IPC 8 data and IPC thesaurus added  

PATDPASPC now contains IPC 8 codes, used according to the 
rules of the IPC Reform (IPC 8), for 2006 EPO publications.  

The IPC thesaurus covering IPC 1-8 is now available in 
PATDPASPC.  The thesaurus is available in the /IPC search and 
expand field, allowing you to view the definitions of IPC codes in 
their respective hierarchies.  It also enables searching across a 
range of IPC codes.

A concise description of the functionality is provided when you 
enter HELP THES at an arrow prompt (=>) in one of the databases 
containing the IPC 1-8 thesaurus.  The hierarchy or relationship 
codes are provided in HELP RCO.

Search tips for using the IPC thesaurus can be found starting on 
page 48 at:   
www.stn-international.de/ipcreform_stn.html

For more information on the IPC Reform, visit:
www.cas.org/EO/ipcreform.html 
www.stn-international.de/stndatabases/details/ipc_reform.html

The revised PATDPASPC Database Summary Sheet is available at:
www.cas.org/ONLINE/DBSS/patdpaspcss.html 

RDISCLOSURE
Research Disclosure
–added to the ALLBIB database cluster 

RDISCLOSURE has been added to the ALLBIB database cluster.  

A complete listing of database clusters is available at:
www.cas.org/ONLINE/CATALOG/CLUSTERS/cover.html

The RDISCLOSURE Database Summary Sheet is available at:
www.cas.org/ONLINE/DBSS/rdisclosuress.html  

REGISTRY/ZREGISTRY
–enhanced with more experimental spectral property data

Beginning February 27, 2006, approximately 42,000 mass spectra 
images from Wiley Subscriptions Services, Inc. (WSS) are being 
added to about 35,000 CAS records in REGISTRY/ZREGISTRY 
on STN.  This addition significantly strengthens the collection of 
spectra properties first made available in 2005.

With this enhancement, MASS/SPEC and MASS SPECTRA/SPEC 
have been added to the search fields, and SPEC.MASS to the 
display fields.

The revised REGISTRY/ZREGISTRY Database Summary Sheets are 
available at:
www.cas.org/ONLINE/DBSS/registryss.html
www.cas.org/ONLINE/DBSS/zregistryss.html 

RUSSIAPAT
Russian Patent Abstracts
–IPC thesaurus added

The IPC thesaurus covering IPC 1-8 is now available in RUSSIAPAT.  
The thesaurus is available in the /IPC search and expand field, 
allowing you to view the definitions of IPC codes in their respective 
hierarchy.  It also enables searching across a range of IPC codes.

A concise description of the functionality is provided when you 
enter HELP THES at an arrow prompt (=>) in one of the databases 
containing the IPC 1-8 thesaurus.  The hierarchy or relationship 
codes are provided in HELP RCO.

Search tips for using the IPC thesaurus can be found starting on 
page 48 at:   
www.stn-international.de/ipcreform_stn.html

For more information on the IPC Reform, visit:
www.cas.org/EO/ipcreform.html 
www.stn-international.de/stndatabases/details/ipc_reform.html

The revised RUSSIAPAT Database Summary Sheet is available at:
www.cas.org/ONLINE/DBSS/russiapatss.html 
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TOXCENTERSM 
–reloaded and enhanced

TOXCENTER has been reloaded, and the following enhancements 
have been made:

• All labels of subfields displayed in the Source (/SO) field are now 
searchable.

• Former stop words are now indexed and no longer removed 
from searches.

• Simultaneous left and right truncation (SLART) is now available 
in the Title (/TI) field, the same as in the Abstract (/AB) and Basic 
Index (/BI) fields.

The following enhancements were made to the MEDLINE file 
segment of TOXCENTER:

• The Source (/SO) field now contains the International Standard 
Serial Number (ISSN) for print and the Electronic ISSN (E-ISSN) 
for electronic journals when available.  Both print and electronic 
ISSNs are searchable and displayable in MEDLINE.

• OLDMEDLINE records now include at least one MeSH heading 
in the Controlled Term (/CT) field.

• A new search and display field, COMMENT (/CM), is now 
available and displays after the SO field in the ALL format.  The 
CM field does not display in the BIB format.  The terms from SEL 
CM with Document Number (/DN) appended allow you to find 
referenced PubMed IDs in TOXCENTER.

The reload of the MEDLINE file segment of TOXCENTER 
incorporates the annual update on December 11, 2005, to Medical 

Subject Headings (MeSH), the National Library of Medicine’s 
(NLM) controlled vocabulary used for subject indexing and 
retrieval, which included:

• Over 990 new MeSH Headings 

• More than 185 updated MeSH Headings to reflect more current 
terminology  

For example, Fetal Anoxia is now indexed under Fetal Hypoxia.

=> S FETAL HYPOXIA/CT

L1        2192 FETAL HYPOXIA/CT  (4 TERMS)
                 (‘FETAL HYPOXIA’+XUSE/CT)

=> S FETAL ANOXIA/CT

L2        2192 FETAL ANOXIA/CT  (4 TERMS)
                 (‘FETAL HYPOXIA’+XUSE/CT)

You may want to update your current-awareness alerts (SDIs) and 
saved queries to reflect the MeSH terminology changes.  However, 
regardless of the term you enter, STN recognizes the relationship 
between the old vocabulary and the new terms and will link them 
together automatically.

For more information about changes in the 2006 MeSH, visit:
www.nlm.nih.gov/pubs/techbull/nd05/nd05_med_data_changes.
html

The revised TOXCENTER Database Summary Sheet is available at:
www.cas.org/ONLINE/DBSS/toxcenterss.html  
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Searching link terms in EMBASE
EMBASE (Excerpta Medica) is a 
comprehensive bibliographic database 
that covers the worldwide literature on 
biomedical and pharmaceutical fields.  
It contains the EMTREE codes for drug 
and medical descriptors in the Controlled 
Term (/CT) field.

The /CT field also contains link terms, 
which are concept modifiers (subheadings) 
added where appropriate to EMTREE 
terms.  They are intended to enhance the 
retrieval 
of precise drug information.  

In 1988, two link term groups were 
introduced: 

• Drug links

• Disease links

Drug links may be added only to EMTREE 
terms for drugs and disease links may be 
added only to EMTREE terms for diseases.  
Each link term is additionally represented 
by a 2-letter code.  

To obtain the most precise results in 
searching these link terms with drug, 
disease, or medical descriptors, use the 
(P) proximity operator.  See the examples 
at the right.

Additional resources

In EMBASE, enter the following at an 
arrow prompt (=>):

• HELP LTERMS

• HELP (P)

• HELP (L)  

The EMBASE Database Summary Sheet 
is available at: 
www.cas.org/ONLINE/DBSS/embasess.

Link terms are intended to enhance the retrieval         
            of precise drug information.

Searching a drug link using the (P) proximity operator. 

=> S (FLUNITRAZEPAM (P) PO)/CT
          5922 FLUNITRAZEPAM/CT
        125414 PO/CT
L1          56 (FLUNITRAZEPAM (P) PO)/CT

=> D AN TI HIT

L1 ANSWER 1 OF 56  EMBASE COPYRIGHT (c) 2006 Elsevier 
B.V. All rights reserved on STN 

AN    2006006426  EMBASE  
TI    Twin-to-twin transfusion syndrome: Management options 

and outcomes. 
CT    Medical Descriptors: 
 *twin twin transfusion syndrome: DI, diagnosis
     *twin twin transfusion syndrome: SU, surgery treatment 

outcome surgical technique
   .
   .
   .
     Drug Descriptors: 
     cefazolin: IV, intravenous drug administration
     indometacin
     flunitrazepam: PO, oral drug administration

Searching a disease link using the (P) proximity operator. 

=> S FETUS DISEASE/CT (P) ETIOLOGY/CT
         2749 FETUS DISEASE/CT
  1194882 ETIOLOGY/CT
L8        395 FETUS DISEASE/CT (P) ETIOLOGY/CT

=> D AN TI HIT 4
 
L8    ANSWER 4 OF 395  EMBASE  COPYRIGHT (c) 2006  

Elsevier B.V. All rights reserved on STN 
AN    2006006074  EMBASE  
TI    Concomitant fetal anemia and thrombocytopenia due to 
 anti-D and anti-HPA1a
     alloimmunization [4]. 
CT    Medical Descriptors: 
      *fetus disease: CO, complication
      *fetus disease: DI, diagnosis
      *fetus disease: DT, drug therapy
      *fetus disease: ET, etiology
      *fetus disease: TH, therapy
      *anemia: CO, complication
   .
   .
   .

Search the drug 
name with (P) 
followed by 
PO (for oral 
administration) 
in the /CT field.

Search the 
disease with (P) 
followed by the 
link term 
in the /CT field.
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Version 1.1 enhancements help you share your visualization results

By popular request, STN AnaVist has been 
enhanced with key features.  This article 
discusses: 

• Sharing visualization projects

• Creating project reports 

• Additional enhancements 

 

Sharing visualization projects

Visualization projects can be shared if both 
the sender and receiver have:

• STN AnaVist, Version 1.1

• A full-access STN login ID or STN 
AnaVist Login ID for Shared Projects

The instructions on the next page describe 
how to share projects with others.

Note: STN Easy-only login IDs cannot 
be used.

By popular request,                 
  STN AnaVist                            

     has been enhanced to help 
you share visualization results.

Login IDs for Shared Projects

Login IDs for Shared Projects allow the holder to:

• Download or order STN AnaVist software

• Open STN AnaVist shared projects

• Customize projects, e.g., create new charts, edit terms

• Display, print, and save documents (standard charges apply)

• Perform subset visualizations

STN AnaVist Login IDs for Shared Projects do not permit the holder to create new 
visualizations or perform searches within the software.

All STN AnaVist Login IDs for Shared Projects must be requested by a full-
access STN login ID holder.  All fees incurred by the STN AnaVist Login ID for 
Shared Projects holder are billed to the full-access STN account with which they 
are associated.

To request these login IDs, complete the STN AnaVist Login ID for Shared 
Projects Request Form available at: 
www.cas.org/stnanavist/.
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To save a project for sharing:

1. Select 
 File > Save Copy of “<project 

name>”.

 Or

 Right-click on the name of the project 
listed in the project area and select 

 Save Copy.

 Or

 Right-click on the project tab and select 
Save Copy.

 Note: If you have not worked with your 
project in the current session, ensure 
that it is active by double-clicking the 
project name listed in the project area. 

2. In the Save As window, specify a file 
location and a file name for the saved 
project.

3. Click Save.  

The project is saved in AnaVist eXchange 
format (.avx) as a small file (less than 10 
KB) 

To open a shared project from an e-mail attachment: 

• Double-click the .avx file attachment.

Note: STN AnaVist launches automatically.

To open a project that is saved to your computer or a shared file location: 

1. Select File > Open Project Copy.

2. Locate the .avx file of interest.

3. Click Open.

Or 

Click and drag the .avx file into the STN AnaVist workspace.

Menu items for new features in Version 1.1.
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A Summary Report is a one-page overview 
that includes: 

• Information about the project, e.g., 
creation date, number of documents

• Charts of publication trends, top 
organizations, and top authors/inventors

• Research Landscape 

• A short list of selected documents             
from the project

A Detailed Report is a multiple-page 
document that contains:

• Summary of the project, e.g., databases 
and types of documents searched, total 
number of documents, overall publication 
trends

• Research Landscape

• Top organizations, including publication 
trends

• Collaboration charts, indicating 
documents that were co-authored 
by researchers at more than one 
organization

• Top researchers, including numbers            
of documents

• List of selected documents from                 
the project

Creating project reports

With Version 1.1, you can now create two types of project reports as either .rtf or .pdf 
documents:  

• One-page Summary Reports 

• Multiple-page Detailed Reports 

The instructions on the next page outline the steps for creating these predefined reports.

Sample summary and detailed reports from STN AnaVist.  These predefined reports can be 
created quickly and easily for any visualization project.
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Predefined reports can be created quickly and easily                     
  for any visualization project. Additional enhancements

In addition, enhancements 
in Version 1.1 let you:
 
• Choose whether or not you want 

STN AnaVist to remember your 
login ID for future use

• Create a chart of priority 
application dates by year or           
by date 

• Move the toolbar to any location 
in bar and matrix charts

• Access the Edit Terms feature 
through a new toolbar button 

• Create multiple versions              
      of visualization projects

Additional resources 

For more information about STN AnaVist, visit: 

www.cas.org/stnanavist/

www.stn-international.de/stninterfaces/stnanavist/stn_anavist.html

To create a report:

1. Select File > Create Report for “<project name>”.

 Or

 Right-click on the name of the project listed in the project area and select Create 
Report.

 
 Or

 Right-click on the project tab and select Create Report.

 Note: If you have not worked with your project in the current session, ensure that it is 
active by double-clicking the project name listed in the project area. 

2. Select Summary Report or Detailed Report. 

3. In the Save As window, specify a file location and a file name for the report.  
 Select .rtf or .pdf format.
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As discussed in the Feature article, the 
World Intellectual Property Organization’s 
(WIPO) International Patent Classification 
(IPC) Reform went into effect on January 1, 
2006, for patent-issuing authorities that use 
IPC codes. 

This article highlights the changes that 
have been made in patent databases on 
STN to accommodate new or additional 
IPC Reform-related data: 

• New format for displaying IPC codes

• New fields for searching information     
about IPC codes

• Searching additional information              
 about IPC codes

• Search tips and examples using                  
the IPC Reform data

The examples are taken from CA/CAplus 
and INPADOC, implemented with IPC 8 
data, to demonstrate these changes.

Displaying IPC codes

To make it easy to understand and quickly 
scan additional information about IPC data, 
a new tabular display format (IPC.TAB)             
is available.   

In this format, IPCI CODE groups Initial         
IPC Classifications, and IPCR CODE 
groups Reclassified IPC data.  

In addition, information for each IPC                
is included in clearly labeled columns.

Searching and displaying IPC Reform data

Example of the new IPC.TAB display format.
 
L1   ANSWER 1 OF 10666  CAPLUS  COPYRIGHT 2006 ACS on STN 
 
PI   US 2005275330
 
IPCI CODE       VERSION  POS INV LEVEL    CC ASSIGNMENT   DATE   STAT
--------------- -------  --- --- -----    -- ---------- -------- ----
H01J0001-14     (7)  Main                 US Human      20051215  O
H01J0001-02     (7)  Secondary            US Human      20051215  O
 
PI   US 2003168957
 
IPCI CODE       VERSION  POS INV LEVEL    CC ASSIGNMENT   DATE   STAT
--------------- -------  --- --- -----    -- ---------- -------- ----
H01J0001-14     (7)  Main                 US Human      20030911  O
H01J0019-06     (7)  Secondary            US Human      20030911  O
 
IPCR CODE       VERSION  POS INV LEVEL    CC ASSIGNMENT   DATE   STAT
--------------- -------  --- --- -----    -- ---------- -------- ----
C01B0031-00     (200506)      I  Core     EP Machine    20050722  R
C01B0031-06     (200601)      I  Advanced EP Machine    20050722  R
H01J0001-13     (200506)      I  Core     EP Machine    20050722  R
H01J0001-14     (200601)      I  Advanced EP Machine    20050722  R
H01J0001-30     (200506)      I  Core     EP Machine    20050722  R
H01J0001-304    (200601)      I  Advanced EP Machine    20050722  R

Information available for each IPC

IPC.TAB column Content

VERSION Date, partial date, or edition number of the version of the IPC 
manual of classification

POS (for Position) F (First IPC) 
 L (Later IPC)  
 Main (Main IPC)
 Secondary (Secondary IPC)
 Index (Index IPC)
 Additional (Additional IPC)

INV (for Invention/ I (applied to Invention) 
Non-Invention) N (applied to Non-Inventive aspects)

LEVEL Core (applied at Core level)
 Advanced (applied at Advanced level)
 Subclass (applied at Subclass level)

CC (for Country Code) Two character code for the country or patent-issuing 
 organization 

ASSIGNMENT Human (human-assigned)
 Machine (machine-assigned)

DATE Date (date when the IPC code was applied or updated)

STAT (for Status) O (Original) 
 R (Reclassification) 
 U (Updated)
 D (Deleted)
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This article highlights the changes that have been made                  
in patent databases on STN to accommodate new or additional 

IPC Reform-related data.

Searching IPC codes

The main search fields for searching IPC 
data are: 

Search field Content

/IPC All IPC codes 

/IPCR IPC, Reclassified

/IPCI IPC, Initial Classification

You can use pre-Reform codes with the 
SEARCH or EXPAND command.  The 
system automatically converts the IPC to 
the new format by adding the initial 0 to the 
group designation.  For example, in the IPC 
1-7 format B23K001-02, B is the section, 
23 is the class, K is the subclass, 001 is the 
group, and 02 is the subgroup.  In the IPC 
8 format B23K0001-02, 0001 is the group.

Avoid the truncation symbol “?” because 
the search edit feature that converts the 
pre-IPC Reform format to the 8-character 
IPC-8 format would not be used. 

You can also search a range of IPCs.  See the examples below.

The IPC code is up-posted, which means: 

S A61K/IPC Searches the IPCs at the subclass level
 (groups and subgroups searched)

S A61K0001/IPC  Searches the IPCs at the main group level (subgroups searched)

Searching a single IPC.

=> S C01B031-02/IPC
L1        8111 C01B031-02/IPC
                 (C01B0031-02/IPC)
=> D TI HIT
L1    ANSWER 1 OF 8111  INPADOC  COPYRIGHT 2006 EPO on STN 
TI    Nanoporous carbide derived carbon with tunable pore size.
IPCI  C01B0031-02 [I,A]
      C01B0031-00 [I,C*]

Searching a range of IPCs.

=> S C01B0031-26-C01B0031-36/IPC
L2        5258 C01B0031-26-C01B0031-36/IPC  (6 TERMS)
                 (C01B0031-26+NEXT5/IPC)
=> D HIT 1-2
L2    ANSWER 1 OF 5258  INPADOC  COPYRIGHT 2006 EPO on STN 
IPCR  C01B0007-07 [I,A]; C01B0031-28 [I,A]; C07C0263-10 [I,A]
      C01B0007-00 [I,C*]; C01B0031-00 [I,C*]; C07C0263-00 

[I,C*]
 
L2    ANSWER 2 OF 5258  INPADOC  COPYRIGHT 2006 EPO on STN 
IPCI  C01B0031-36 [I,A]
      C01B0031-00 [I,C*]

Searching IPCs at the main group level.

=> S C01B031/IPC
L4       31110 C01B031/IPC
                 (C01B0031/IPC)
=> D HIT 1
L4    ANSWER 1 OF 31110  INPADOC  COPYRIGHT 2006 EPO on STN 
IPCI  C01B0031-02 [I,A]
        C01B0031-00 [I,C*]
IPCI  C01B0031-02 [I,A]
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Searching additional information 
about IPC codes  

Three new fields are available for searching 
additional information about IPCs.

Search field  Name

/IPC.VER IPC Version or Date

/IPC.KW IPC Keywords

/IPC.ACD IPC Action Date

The table to the right lists the keywords 
you can search in the /IPC.KW field in 
relation to the terms that are displayed 
in the IPC.TAB columns.

Display and search terms for IPC Keywords

Display column  Display codes Search terms in /IPC.KW

POS Additional ICA or ADDITIONAL
 F F or FIRST
 Index ICI or INDEX
 Main ICM or MAIN
 Secondary ICS or SECONDARY
 L L or LATER

Level Advanced ADVANCED or A
 Core C or CORE 
 Subclass SUBCLASS or S

STAT   D DELETED or D
 O IPCI or INITIAL or O or ORIGINAL
 R RECLASSIFICATION or R 
 U  UPDATED or U

INV I I or INVENTION
 N N or NON-INVENTION

ASSIGNMENT Human Human
 Machine Machine

CC Country Code Country Code, e.g., US, EP, DE
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Search tips and examples

When searching IPC data, keep the 
following in mind:

• Search IPC codes in pre-Reform as well 
as IPC 8 fields, e.g., /ICM, /IPC, IPC.KW 
(because both may be found in a given 
database).  

• Use the (S) operator to correlate a 
particular IPC code with some additional 
information, e.g., a keyword from the  
/IPC.KW field.

For example, to search for pre-Reform and 
IPC 8 patents in which the IPC B23K011 
was applied to main or invention-related 
information, include the following terms:

• S B23K011/ICM

• S B23K011/IPC (S) MAIN/IPC.KW

• S B23K011/IPC (S) INVENTION/IPC.KW

Searching IPC B23K011 applied to main or invention-related information. 
 
=> FILE CAPLUS

=> S B23K011/ICM
L1         914 B23K011/ICM

=> D TI HIT 
   
L1   ANSWER 1 OF 914  CAPLUS  COPYRIGHT 2006 ACS on STN 
TI   Electrode composite material for resistance spot welding
     of aluminum alloy
IC   ICM  B23K011-30

=> S B23K011/IPC (S) (MAIN OR INVENTION)/IPC.KW
          2058 B23K011/IPC
                 (B23K0011/IPC)
       3284685 MAIN/IPC.KW
       2351313 INVENTION/IPC.KW
L2        1360 B23K011/IPC (S) (MAIN OR INVENTION)/IPC.KW

=> D TI IPC.TAB 1-2
   
L2   ANSWER 1 OF 1360  CAPLUS  COPYRIGHT 2006 ACS on STN    
TI   Spot welding process [Machine Translation].
 
PI   JP 2006061916
 
IPCI CODE       VERSION  POS INV LEVEL    CC ASSIGNMENT   DATE   STAT
--------------- -------  --- --- -----    -- ---------- -------- ----
B23K0011-11     (200601)  F   I  Advanced JP Human      20060210  O <--
B23K0011-14     (200601)  L   I  Advanced JP Human      20060210  O <--
B23K0011-30     (200601)  L   I  Advanced JP Human      20060210  O <--

   
L2   ANSWER 2 OF 1360  CAPLUS  COPYRIGHT 2006 ACS on STN 
TI   Method for resistance spot welding of metal plates and metal sheets,  
     method for formation of resistant spot weld joints, and method for
     manufacture of automobile bodies
 
PI   JP 2006055898
 
IPCI CODE       VERSION  POS INV LEVEL    CC ASSIGNMENT   DATE   STAT
--------------- -------  --- --- -----    -- ---------- -------- ----
B23K0011-11     (200601)  F   I  Advanced JP Human      20060206  O <--
B23K0011-30     (200601)  L   I  Advanced JP Human      20060206  O <--
   

=> S L1 OR L2
L3        1365 L1 OR L2

Additional resources

For additional information about IPC 
Reform as it relates to STN databases, 
visit:

www.cas.org/EO/ipcreform.html 

www.stn-international.de/stndatabases/ 
details/ipc_reform.html 

See also the Patent Interchange          
article, Verifying IPC codes with 
the        IPC thesaurus in CA/CAplus and 
USPATFULL/USPAT2, in the January/
February 2006 issue of STNews.
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X.25 communication 
option no longer 
available after June 2006
If you currently access STN via dial-up, 
also known as Value Added Network (VAN) 
or X.25 access, you will need to change 
your means of access by June 2006.  After 
June 2006, there will no longer be an X.25 
communication method for STN-Columbus 
or STN-Tokyo customers.
 
To ensure that your future access to STN        
is uninterrupted, please change now 
to Internet access.  Simply follow these 
steps:
 
1. Open STN Express with Discover!.

2. Click the Setup button on the                  
main toolbar.

3. In the STN Setup window, click Modify.

4. Select Winsock (Internet) from                   
the Connect via: drop-down menu.

 
In addition, two secure access options  
have been added to the STN Express with 
Discover! software to alleviate concerns 
about the safety of data transmittal over 
the Internet.  You can now access STN 
through:
 
• Secure telnet session using RSA 

encryption in Version 8.0 and higher

• Secured Socket Layer Virtual Private 
Network (SSL VPN) in Version 8.01 and 
higher

To purchase STN Express with Discover!, 
Version 8.01, visit: 
www.cas.org/ONLINE/STN order
express.html
 
For step-by-step instructions on how to set 
up a secure connection to STN Express 
with Discover!, refer to the Take Note article 
in the January/February 2006 issue of 
STNews available at:
www.cas.org/STNEWS/JANFEB06/
takenote.html#X25
 
Please contact your STN Service Center 

You need to currently have the Analysis 
Edition of STN Express with Discover!, 
Version 8.0 or 8.01, to download this free 
maintenance release.  To verify that you 
are using one of these versions:
 
1. Launch STN Express.

2.  Select Help > About STN Express         
from the main menu.

STN Express with Discover!, Version 8.01a, 
is also available directly from the Web 
via the Purchase and Download site 
(casweb.cas.org/stnexpress/html/english/
login.html), which is available to you 
if you are an STN-Columbus customer 
with an STN login ID and password.
 
You can also obtain the software 
on CD-ROM:
 
• Use the printed or PDF version of the 

STN Express with Discover! Order Form

• Request a CD-ROM online

For more information about STN Express 
with Discover!, visit:
www.cas.org/ONLINE/STN/discover.html 

New STN AnaVist pricing 
implemented
 
New pricing for STN AnaVist went into 
effect on March 1, 2006.  Key changes 
include:
 
• New visualization fees that include 

unlimited subset visualizations

• No charge for STN AnaVist software              
or upgrades

For details, visit:
www.cas.org/stnanavist/prices.html

In addition, a copy of the 2006 STN 
AnaVist Price List is included with this 
issue of STNews.

Free maintenance release 
of STN Express with 
Discover! (Version 8.01a) 
now available 
A free maintenance release (Version 
8.01a for Windows®) for STN Express with 
Discover! is now available.  This release 
provides fixes for specific issues that have 
been reported.  The fixes primarily affect 
the structure drawing and post-processing 
features, including: 
 
• The Variable Group (R-Group) Analysis 

Table Tool no longer locks up for certain 
.rgp (R-group) files when the “Use 
structure skeleton, ignore bonds” option    
is selected.

• Bond Characteristics no longer 
unexpectedly change to “EXACT”              
for benzene in a repeating group            
when the ring system is isolated.

• .xss (Express Saved Sequences)          
        or .trn (Transcript) files can now be 
opened when using Japanese mode. 

To upgrade to this maintenance release 
from an existing version of the Analysis 
Edition (Version 8.0 and higher): 
 
1.   Launch STN Express.

2.   Select Web from the toolbar.

3.   Select the appropriate STN Service 
Center.

4.   Select Free Maintenance Upgrades.

 
Or, for instructions on how to download     
this maintenance release, visit:
www.cas.org/Support/express80/win/
patches/patches.html
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CAS contacts 

CAS Customer Care:  Phone: 800-753-4227 (North America)  
 or 614-447-3700 (worldwide)

CAS: Phone: 800-848-6538 (North America)  
 or 614-447-3600 (worldwide)

E-mail: help@cas.org

CAS web page: www.cas.org

STN web page:   www.cas.org/stn.html

Information www.cas.org/infopro/ 
Professionals: 

Patent Information www.cas.org/patents/
on STN: 

STNews:  www.cas.org/STNEWS/stnewscover.html

STNews back issues:  www.cas.org/STNEWS/backissue.html

STNewsline—did you sign up?
STNewsline, our electronic newsletter, is published every 
month.  Are you receiving it?

You are not automatically signed up to receive STNewsline just 
because you receive STNews.  We need your e-mail address to 
send it to you.

To receive the latest news about STN by e-mail, visit: 
www.cas.org/STNEWS/signup.html

Or, complete this form and fax it to: STNews Editor, 
614-447-3837.

❑  YES!  Sign me up to receive STNewsline:

 NAME

 E-MAIL ADDRESS

 ORGANIZATION

 COUNTRY

$500 credit toward visualization usage
From March 1 until August 31, 2006, you can 
explore STN AnaVist while taking advantage of 
a $500 credit* toward STN AnaVist visualization 
usage.  
The $500 credit will be automatically applied to 
your invoiced charges.

The $500 credit applies to the following billable 
activities:

• Answer set creation (search)

• Visualization

The $500 credit does not apply to the following 
billable activities:

• Display, Save, or Print document records

• Use of the Download CAplus Documents feature, 
including CAplus document charges and 
download visualization fees

* This credit is valid for all existing STN® login IDs.  Note: STN Easy®–only login IDs 
are excluded from this offer.  The $500 credit will be automatically applied beginning 
March 1, 2006, and carried over month-to-month until the $500 is used or until 
August 31, 2006.  This offer is currently not available in Japan.

For more information on STN AnaVist, visit www.cas.org/stnanavist/.

Try 
STN AnaVist!
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STNews binders available

Need a binder for your 2006 issues of STNews?  CAS has STNews 
binders available.

To request your free binder, contact CAS Customer Care at 
help@cas.org.  Be sure to include your name and complete 
address with your request.

CPhI Japan (Convention on 
Pharmaceutical Ingredients)
April 24-26 
Tokyo, Japan

ACHEMA (International 
Exhibition on Chemical 
Engineering, Environmental 
Protection, and 
Biotechnology) 
May 15-19 
Frankfurt, Germany 

Biomed Research Equipment 
& Supplies Exhibit 
May 17-18 
Fort Detrick, Maryland

PATINFO 2006 
May 18-19 
Illmenau, Germany 

PIUG Annual Conference 
May 21-25 
Minneapolis, Minnesota

Canadian Chemical Society 
Meeting 
May 27-31 
Halifax, Novia Scotia

SLA Annual Conference 
June 11-14
Baltimore, Maryland 

BioPharma Opportunities 
June 13-15 
Shanghai, China 

AALL (American Association 
of Law Libraries) 
July 8-12
St. Louis, Missouri

China Chemical Society 
Meeting 
July 11-15
Jilin, China

International Isotope Society 
Symposium 
July 16-20
Edinburgh, Scotland 

2006 CAS exhibits
www.cas.org/exhibit.html

Drug Discovery 
Technology Conference 
August 7-12 
Boston, Massachusetts 

International Federation 
of Library Associations 
(IFLA) 
August 20-24
Seoul, Korea

1st European Chemistry 
Congress 
August 27-31
Budapest, Hungary

IPO Annual Meeting 
September 10-12
Chicago, Illinois 

ACS National Fall Meeting 
September 10-14
San Francisco, California

LIASA (Library and 
Information Association of 
South Africa Conference) 
September 25-29
Pretoria, South Africa

BioTech Forum 
September 26-28
Copenhagen, Denmark

CPhI (Convention 
on Pharmaceutical 
Ingredients) 
October 3-5
Paris, France

Drug Discovery 
Technology India
October 10-12
Mumbai, India 

ICIC 2006 
October 22-25
Nimes, France 

STNews
STNews is written and produced cooperatively by Chemical 
Abstracts Service and FIZ Karlsruhe, and printed in three separate 
editions.

Staff, North American 
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Editors: Kristina Gobel
  Crystal Poole
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Dr. Gerhard Herlan
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Quoting or republishing of material from STNews is encouraged 
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CAS requests that a copy of the reproduced material be sent to 
CAS Customer Care, P.O. Box 3012, Columbus, OH 43210-0012 
U.S.A. Please send all address changes to CAS, P.O. Box 3012,  
Columbus, OH 43210-0012 U.S.A. E-mail us at help@cas.org.

Contributing
Editors:
Jim Blake
Elizabeth Haines

Design/Production: 
Pat Farnlacher
Nadine Seeley
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2006 STN instructor-led seminars
www.cas.org/training/schedule.html

Columbus, Ohio

5/16 9:00 a.m.-12:00 p.m. STN Basics

5/16 1:00 p.m.-4:00 p.m. STN Intermediate 

5/17 9:00 a.m.-12:00 p.m. Basic Patent Search   
  Techniques

5/17 1:00 p.m.-4:00 p.m. Patent Family and Legal  
  Status Search Techniques 

5/18 9:00 a.m-12:00 p.m. Markush Searching in the  
  Patent Literature

5/18 1:00 p.m.-4:00 p.m. Reaction Searching in  
   CASREACT® 

All STN instructor-led seminars in North America are free, but 
registration is required.

To register, visit:
www.cas.org/training/regform.html

Previously recorded CAS e-Seminars 
available
https://casevents.webex.com

Previously recorded CAS e-Seminars include:

STN AnaVist
• STN: Introduction to STN AnaVist
• Creating Result Sets for Use in STN AnaVist 
• Going Beyond Basic Navigation on STN AnaVist 
• Using the Custom Grouping Capabilities in STN AnaVist
• Using the STN AnaVist Interactive Visualization Workspace

STN Express with Discover! 
• STN: Using Discover! Wizards in STN Express
• STN: What’s New with STN Express? (Version 8.0)

Structure Techniques
• STN: Structure and Substructure Searching Tips
• STN: Advanced Structure Search Techniques – Ring 

Information 
• STN: Advanced Structure Searching with Filters/Screens
• STN: Stereochemistry in the CAS Registry File 
• STN: Using Boolean Operators in Structure Searching 
• STN: Introduction to Polymers 
• STN: Finding Post-Treated and Blended Polymers
• STN: Organometallics and Coordination Compounds
• STN: Reaction Searching 
• STN: All About MARPAT
• STN: Advanced MARPAT Techniques

Patent Searching
• STN: Increasing Confidence in Search Results
• STN: Expanding Your Prior Art Search with Controlled 

Terminology
• STN: Searching for Patent Families
• STN: Multifile Patent Searching
• STN: Patent Citation Searching
• STN: Improving Searches by Including Patent Classification 

Codes
• STN: “Biotextology” – Text Search Techniques for Biological 

Information

Miscellaneous
• STN: Have It Your Way – Customizing Your STN Account  
• STN: Automating Your Search 
• STN: Multiple Methods of Keeping Current
• STN: Finding Regulatory Information 
• STN: Strategies for Finding Novel Formulations
• STN: Finding Clinical Trial and Drug Pipeline Information 

2006 CAS e-Seminars
www.cas.org/training/schedule.html

5/11 9:00-10:00 a.m. STN: Capitalizing on IPC Reform
 
5/30 1:00-2:00 p.m. STN: Property Searching in            
   CAS REGISTRYSM

6/8 9:00-10:00 a.m. STN: Property Searching in 
  CAS REGISTRY

6/27 1:00-2:00 p.m. STN: Is That Patent Still Valid?   
  Finding Patent Expirations and  
  Extensions

7/13 9:00-10:00 a.m. STN: Is That Patent Still Valid?   
  Finding Patent Expirations and  
  Extensions

All times are U.S. Eastern Time.

For a description of each e-Seminar and to register, visit:
https://casevents.webex.com/



In case you missed it:

STNews Nov/Dec
• 2005–Year in review

• Maximizing use of the SET 
 command

• Utilizing SET RANGE or RANGE= 
 in IFIPAT/IFICDB/IFIUDB

• STN AnaVist, Version 1.01, 
 allows the export/download 
 of CAplus documents

• Using STN AnaVist for competitive       
 analysis of patents

• STN Express with Discover!, 
 Analysis Edition, Version 8.01 
 for Windows, now available

STNews Jan/Feb
• Exploring property information 
 on STN

• Searching and displaying 
 experimental spectral data 
 in REGISTRY

• Manual current-awareness 
 searching on STN

• Verifying IPC codes with the 
 IPC thesaurus in CA/CAplus 
 and USPATFULL/USPAT2 

• Variable group analysis enhanced      
 in STN Express with Discover!, 
 Version 8.01

• STN® on the WebSM now offers 
 new Windows structure plug-in

You can find it easily by searching 
the CAS web site at:  
www.cas.org/websearch.html
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2006 STN AnaVist Price List

Japan Science and Technology 
 Agency (JST)
STN Japan
5-3 Yonbancho, Chiyoda-ku
Tokyo 102-8666, Japan
Phone: 81 3-5214-8493
Fax: 81 3-5214-8450
E-mail:  helpdesk@mr.jst.go.jp
Internet:  pr.jst.go.jp/db/STN/

In North America
Chemical Abstracts Service
STN North America
P.O. Box 3012
Columbus, Ohio 43210-0012 U.S.A.
Phone: 800-753-4227 (North America)
 614-447-3700 (worldwide)
Fax: 614-447-3751
E-mail:  help@cas.org
Internet: www.cas.org/stn.html

In Europe
FIZ Karlsruhe
STN Europe
P.O. Box 2465
76012 Karlsruhe
Germany
Phone: (+49) 7247808-555
Fax: (+49) 7247808-259
E-mail:  helpdesk@fiz-karlsruhe.de
Internet:  www.stn-international.de

In Japan
Japan Association for International 
 Chemical Information (JAICI)
STN Japan
Nakai Building
6-25-4 Honkomagome, Bunkyo-ku
Tokyo 113-0021, Japan
Phone: 81 3-5978-3601 (Technical Service)
Phone: 81 3-5978-3621 (Customer Service)
Fax:  81 3-5978-3600
E-mail: helpdesk@jaici.or.jp (Technical Service)
E-mail: cas-stn@jaici.or.jp (Customer Service)
Internet: www.jaici.or.jp

A division of the American 
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